Manual

3CX Phone System for Windows
Version 6.0
# Table of Contents

1. Introduction to 3CX Phone System for Windows ................................................................. 9  
   What is 3CX Phone System for Windows? ........................................................................... 9  
   Benefits of an IP Phone System / IP PBX ........................................................................ 9  
   How an IP Phone system works ...................................................................................... 11  
   SIP phones ......................................................................................................................... 11  
      Software based SIP phones .......................................................................................... 12  
      Hardware based SIP Phones ...................................................................................... 12  
      Analogue phones using an ATA adapter ................................................................... 12  
   3CX Phone System components ..................................................................................... 12  
   3CX Phone System editions ............................................................................................ 13  
   What’s new in 3Cx Phone System V6? ............................................................................ 13  
      All versions .................................................................................................................. 13  
      Small Business, Pro and Enterprise editions .............................................................. 14  

2. Installing 3CX Phone System for Windows .......................................................................... 15  
   System requirements ....................................................................................................... 15  
      Windows Vista users: ................................................................................................. 15  
      Windows 2008 users: ............................................................................................... 15  
   Run set-up ....................................................................................................................... 16  
   Activating 3CX Phone System ...................................................................................... 16  
   Firewall configuration ..................................................................................................... 17  
      3CX Phone System behind a NAT / firewall ............................................................ 17  
      Firewall installed on the 3CX Phone System machine ........................................... 18  
   Installing the 3CX VOIP Client ...................................................................................... 18  
   The 3CX VOIP Client User manual .............................................................................. 19  

3. Creating Extensions ........................................................................................................... 21  
   Introduction ...................................................................................................................... 21  
   Adding Extensions .......................................................................................................... 21  
   User and Authentication information ............................................................................. 22  
   Phone provisioning .......................................................................................................... 23  
   Voice mail configuration ................................................................................................. 23  
   Configure extension behaviour on busy, no answer etc. ............................................... 24
Calling ......................................................................................................................... 44
8. Adding Direct numbers using DID/DDI lines ................................................................. 47
    Introduction .................................................................................................................. 47
    DID numbers and 3CX Phone System – How it works .................................................. 47
    Adding a DID line ......................................................................................................... 47
    Troubleshooting DID lines ........................................................................................ 49
9. Ring groups, Call Queues, Paging / Intercom ................................................................. 51
    Ring Groups .................................................................................................................. 51
    Paging / Intercom (Paid editions only) ....................................................................... 52
    Call Queues (Paid editions only) ................................................................................ 53
10. Call conferencing .......................................................................................................... 55
    Introduction .................................................................................................................. 55
    Enabling conferencing ............................................................................................... 55
    Creating a call conference .......................................................................................... 55
11. Generating Call Reports ............................................................................................... 57
    Introduction to reports ................................................................................................. 57
    Installing 3CX Call Reporter ...................................................................................... 57
    Running 3CX Call Reporter ........................................................................................ 57
12. Connecting 3CX Phone Systems .................................................................................. 59
    Introduction .................................................................................................................. 59
    Creating a bridge ......................................................................................................... 59
    Calling a party on the other 3CX Phone System ......................................................... 61
13. General configuration .................................................................................................. 63
    Introduction .................................................................................................................. 63
    Admin credentials ....................................................................................................... 63
    General Settings .......................................................................................................... 63
    SIP Port ........................................................................................................................ 63
    Ports to use for internal calls ...................................................................................... 64
    Ports to use for external calls ...................................................................................... 64
    Voicemail and FAX delivery settings ......................................................................... 64
    STUN Server Options ................................................................................................. 65
    Settings for direct SIP calls ....................................................................................... 65
    Logging Level .............................................................................................................. 65
Configuring office hours................................................................................................................... 66
Phonebook............................................................................................................................................... 67
Exchange 2007 Unified Messaging Integration ................................................................................... 67
e 164 number processing ...................................................................................................................... 68
Firewall options ....................................................................................................................................... 69
Other ....................................................................................................................................................... 69
Backup and Restore ............................................................................................................................. 70
Running backup & restore from the command line: ............................................................................ 70
Scheduling backup & restore .................................................................................................................. 70
System prompts ....................................................................................................................................... 71
Update console ......................................................................................................................................... 71
14. The HTTP API .................................................................................................................................... 73
Introduction ............................................................................................................................................ 73
HTTP functions available ..................................................................................................................... 73
To disable an extension ........................................................................................................................... 73
To disable external calls from an extension ......................................................................................... 73
To record calls to and from an extension ............................................................................................ 73
To automatically trigger a call ............................................................................................................... 73
15. Fax server .......................................................................................................................................... 75
Introduction ............................................................................................................................................ 75
Sending faxes overview ........................................................................................................................ 75
Receiving faxes overview ....................................................................................................................... 75
Configuring 3CX Fax Server ................................................................................................................. 75
Fax receiving configuration .................................................................................................................... 76
Fax sending configuration ....................................................................................................................... 76
Step 1: Install Microsoft Fax Server ..................................................................................................... 76
Step 2: Install the 3CX Microsoft Fax driver ....................................................................................... 78
Step 3: Configuring Microsoft Fax to use the 3CX Fax server driver ............................................... 78
Step 4: Install the Fax clients ................................................................................................................. 81
16. Troubleshooting ............................................................................................................................... 85
Introduction ............................................................................................................................................ 85
Manual ..................................................................................................................................................... 85
Configuration guides ............................................................................................................................. 85
1. Introduction to 3CX Phone System for Windows

What is 3CX Phone System for Windows?

3CX Phone System is a software-based IP PBX that replaces a traditional PBX and delivers employees the ability to make, receive and transfer calls. The IP PBX supports all traditional PBX features. An IP PBX is also referred to as a VOIP Phone System, IP PABX or SIP server.

Calls are sent as data packets over the computer data network instead of via the traditional phone network. Phones share the network with computers and separate phone wiring can therefore be eliminated.

With the use of a VOIP gateway, you can connect existing phone lines to the IP PBX and make and receive phone calls via a regular PSTN line. The 3CX phone system uses standard SIP software or hardware phones, and provides internal call switching, as well as outbound or inbound calling via the standard phone network or via a VOIP service.

Benefits of an IP Phone System / IP PBX

Much easier to install & configure then a proprietary phone system:
A software program running on a computer can take advantage of the advanced processing power of the computer and user interface of Windows. Anyone with an understanding of computers and windows can install and configure the PBX. A proprietary phone system often requires an installer trained on that particular proprietary phone system.

Easier to manage because of web based configuration interface:
A VOIP phone system has a web based configuration interface, allowing you to easily maintain and fine tune your phone system. Proprietary phone systems often have difficult to use interfaces which are designed so that only the phone system installers can use it effectively.

Call cost reduction:
You can save substantially by using a VOIP service provider for long distance or international calls. Easily connect phone systems between offices/branches via the Internet or WAN and make free phone calls.

No need for separate phone wiring – use computer network:
A VOIP phone system allows you to connect hardware phones directly to a standard computer network port (which it can share with the adjacent computer). Software phones can be installed directly onto the PC. This means that you do not need to install & maintain a separate wiring network for the phone system, giving you much greater flexibility to add users/extensions. If you are moving into an office and have not yet installed phone wiring, you can save significantly by just installing a computer network.

No vendor lock-in:
VOIP phone systems are open standard – all modern IP PBX systems use SIP as a protocol. This means that you can use almost any SIP VOIP phone or VOIP gateway hardware. In contrast, a proprietary phone system often requires proprietary phones, designed specifically for that phone system and proprietary expansion modules to add features and lines.

**Scaleable:**
Proprietary systems are easy to outgrow: Adding more phone lines or extensions often requires expensive hardware upgrades. In some cases you need an entirely new phone system. Not so with a VOIP phone system: a standard computer can easily handle a large number of phone lines and extensions – just add more phones to your network to expand!

**Better customer service & productivity:**
Because calls are computer based, it is much easier for developers to integrate with business applications. For example: an incoming call can automatically bring up the customer record of the caller, dramatically improving customer service and cutting cost. Outbound calls can be placed directly from Outlook, removing the need for the user to type in the phone number.

**Software based Phones are easier to use:**
It is often difficult to use advanced phone system features such as conferencing on proprietary phones. Not so with software based SIP phones – all features are easily performed from a user friendly windows GUI.

**More features included as standard:**
Because a VOIP phone system is software based, it is easier for developers to improve feature sets and performance. Therefore most VOIP phone systems come with a rich feature set, including auto attendant, voice mail, call queuing and more. These options are often very expensive in proprietary systems.

**Better control via better reporting:**
VOIP settings store inbound and outbound call information in a database on your server, allowing for much more powerful reporting of call costs and call traffic.

**Better overview of current system status and calls:**
Proprietary systems often require expensive ‘system’ phones to get an idea what is going on in your phone system. Even then, status information is cryptic at best. With VOIP systems you can define which users can see phone system status graphically via a web browser.

**Allow users to hot plug their phone anywhere in the office:**
Users simply take their phone, plug it into the nearest Ethernet port and they keep their existing number!

**Allows easy roaming of users:**
Calls can be diverted anywhere in the world because of the SIP protocol characteristics
How an IP Phone system works

A VOIP Phone System, also referred to as an IP PBX, consists of one or more SIP standard based phones, an IP PBX server and optionally a VOIP Gateway. The IP PBX server is similar to a proxy server: SIP clients, being either soft phones or hardware based phones, register with the IP PBX server, and when they wish to make a call they ask the IP PBX to establish the connection. The IP PBX has a directory of all phones/users and their corresponding sip address and thus is able to connect an internal call or route an external call via either a VOIP gateway or a VOIP service provider.

![Figure 1 - VOIP Phone System Overview](image)

The image illustrates how an IP PBX integrates on the network and how it uses the PSTN or Internet to connect calls.

SIP phones

A VOIP phone system requires the use of SIP phones. These phones are based on the Session Initiation Protocol (SIP), an industry standard to which all modern IP PBXs adhere. The SIP protocol defines how calls should be established and is specified in RFC 3261. Because of SIP, it is possible to mix and match IP PBX software, phones and gateways. This protects your investment in the phone hardware. SIP phones are available in several versions/types:
Software based SIP phones

A software based SIP phone is a program which makes use of your computers microphone and speakers, or an attached headset to allow you to make or receive calls. Examples of SIP phones are the included 3CX VOIP Client, SJPhone from SJlabs or X-Lite from Counterpath.

Hardware based SIP Phones

Figure 2 - A hardware sip phone

A hardware based SIP phone looks like and behaves like a normal phone. It's actually a mini computer that connects directly to the computer network. Because they have an integrated mini hub, they can share a network connection point with a computer, eliminating the need for an additional network point for the phone. Examples of hardware SIP phones are GrandStream GXP-2000 or SNOM 320.

Analogue phones using an ATA adapter

Figure 3 - An ATA adapter

If you want to use your current phone with the VOIP phone system, you can use an ATA adapter. An ATA adapter allows you to plug in the Ethernet network jack into the adapter and then plug the phone into the adapter. This way your old ‘regular’ phone will appear to the VOIP phone system software as a SIP phone.

3CX Phone System components

3CX Phone System consists of the following components:
• The SIP server service – this is a Windows service that sets up the calls using the SIP protocol. It performs the PBX functions such as call routing, call transfer and so on.

• A Media server service – this is a Windows service that performs call streaming, i.e. the actual audio conversation.

• A Management Console – to allow for web based configuration of the phone system. 3CX Phone System includes Apache web server, which is fast, scalable and secure.

• A database server service (Postgresql) – this is a light-weight SQL database server that stores all the phone system configuration settings.

• The Digital receptionist service – This services can answer calls and offer callers options.

• The Voice mail manager service – This service manages the voice mail boxes.

• The 3CX VOIP client – This is a light weight SIP Phone client which allows users to manage their extensions and calls from their desktop. Calls can be made either using the in built SIP phone or using a SIP desk phone.

3CX Phone System editions


What’s new in 3Cx Phone System V6?

All versions

• Support for Patton gateways with firmware version 5.1, and support for more country tone sets.

• Support for Vegastream gateways

• Improved IVR functionality – It’s no longer necessary to specify extension number when you are picking up your voice mail from your extension. It is also possible to listen to own voice mail greeting from personal voice mail menu.

• Active calls page allows administrators to see all active calls in the system and optionally disconnect them.

• Improved backup and restore process which is much faster than previous versions

• Ability to associate DID numbers with VOIP providers

• Windows 2008 support
• Ability to trigger backup and restore from the command line, allowing for scheduled backups.
• Greatly improved SIP interoperability
• Most VOIP providers, Gateways and phones can now stream audio directly, rather then via the PBX, greatly improving voice quality and performance.

Small Business, Pro and Enterprise editions

• Call conference service – that allows you to create conferences with up to 32 participants (license permitting)
• Intercom – ability to call an extension and force immediate pickup (phone will automatically go to speaker phone). This can be used as intercom at doors, or by managers. Audio will be 2 way. SNOM, Aastra and Linksys phones are supported.
• Paging – ability to setup a ring group that allows one extension to page many extensions at one go and broadcast a message. SNOM, Aastra and Linksys phones are supported.
• Support for BLF provisioning – BLF lights indicating extension status on phones can now be provisioned automatically. SNOM, Aastra and Grandstream phones are supported.
• Improved Call Queue performance.
• Call Queuing status - Ability to view all queues, which extensions are logged in as agents, as well as a list of callers waiting in the queue.
• Ability to provision phonebooks to Aastra, Grandstream and SNOM phones. All extensions will be listed, as well as the ability to add custom entries
• Extended HTTP API
  o Ability to switch recording on / off
  o Ability to disable an extension
  o Ability to disable outbound calls for an extension
  o Ability to set away/available status
  o Ability to login/logout of queues
2. Installing 3CX Phone System for Windows

System requirements

3CX Phone System for Windows requires the following:

- Windows XP, Vista, 2000 (server & professional), 2003 server or 2008
- Ports 5060 (SIP), 5481 (Apache) to be free and open and 5480 (Postgres), 5482 (Media server) to be free. If you want to use the 3CX Tunnel, then you also need to open TCP port 5080
- SIP standard based software or hardware phones
- Depending on number of simultaneous calls, 512 megabytes of memory (small 4 simultaneous calls environments) to 1 gigabyte ram and up for larger environments (8 simultaneous calls and up.
- Optional VOIP Gateway (if you need to connect PSTN phone lines)
- Optional VOIP service provider account (if you want to place calls via the internet)
- If you are using a VOIP provider, you must have a firewall that is configured to do static port mapping. A static IP is highly recommended also! For more information see: http://www.3cx.com/support/nat-firewalls.html

You will need to have a good basic understanding of Windows Networking. It is recommended to read up on IP PBX’s & SIP. For more information visit the IP PBX FAQ at http://www.3cx.com/PBX/IP-PBX-faq.html

Windows Vista users:

To install 3CX Phone System on Vista, you need to disable UAC (user account control). To disable UAC do the following:

1. Open Administrative Tools in Control Panel and double-click on System Configuration
2. Click Continue to accept the UAC prompt
3. Select the Tools tab, scroll down and select Disable UAC
4. Click Launch and Reboot your machine

Windows 2008 users:

You will need to install additional components. Go to

1. Control Panel > Programs and Features
2. Turn Windows Features on or off > Features
3. Now Add features: Desktop Experience, Quality Windows Audio Video Experience (Optional). This will install all the codecs required by 3CX for audio in Windows.

Run set-up

1. Download the latest version of 3CX Phone System from http://www.3cx.com/ip-pbx/downloadlinks.html. Run set-up by double-clicking on the file 3CXPHONE SYSTEM6.msi. Click 'Next' to start installation.

2. You will be asked to review and approve the license agreement, as well as to choose an installation location. 3CX Phone System will need a minimum of approximately 50 MB of free hard disk space. You will need to reserve additional space to store voice mail files & prompts.

3. Set-up will ask you how many digits you wish your extension numbers to be. It will ask you for a preferred username and password, which you will need to logon to the management console and manage the phone system. Finally it will ask you for your mail server name and reply to address. These settings are used to send email notifications to users of new voice mail.

4. Set-up will prompt you for the FQDN of 3CX Phone System. IP phones contact the phone system server using an IP OR an FQDN. If using an FQDN, then you must specify the FQDN of the server. This value is not relevant if you specify the IP of the server in the phone configuration. For more information, see http://www.3cx.com/support/sip-domain.html

5. Click ‘Install’ to start the installation of 3CX Phone System. Setup will now copy all files and install the necessary Windows services. Click ‘Finish’ when ready.

After Set-up has completed, you can connect to the 3CX Phone System Management Console by clicking on the management console short cut in the 3CX Phone System program group.

To connect to the management console from a remote machine, start a web browser and enter the name of the machine on which 3CX Phone System is installed, followed by port 5481. (For example: http://phone-system:5481)

**Note:** If running Windows XP Service Pack 2 with Windows Firewall enabled, after installation, Windows XP will request confirmation to continue blocking “Apache HTTP Server” and “3CX PBX server”. Click the "Unblock" button on these dialogs!

**Activating 3CX Phone System**

If you have purchased a Small Business, Pro or Enterprise version then you can activate your license by going to the General > Activate License page in the 3CX Management Console.
Activating your license

Enter your license key, Company, Contact Name, E-mail, Telephone and Country and click on “Activate” to activate your license. This information will be sent to our license key server and your license key and installation will be activated. You will need to do this each time you re-install 3CX Phone System or install an upgrade.

Firewall configuration

There are 2 scenarios in which you will need to update your firewall configuration:
1. If your PBX server is behind a NAT / firewall and you intend to use a VOIP provider
2. If you are using a firewall on the PBX server itself, for example Windows Firewall

3CX Phone System behind a NAT / firewall

The best place for 3CX Phone System is on a machine behind the firewall. This configuration is easier and more secure. If you will just use PSTN lines, you don’t even need to make any changes to your firewall configuration.

If you intend to use a VOIP Provider, then you will need to open the following ports to allow 3CX Phone System to communicate with the VOIP Provider:
- Port 5060 (UDP) for SIP communications (send & receive) MUST BE STATICALLY MAPPED. See sample firewall configuration at http://www.3cx.com/support/linksys-configuration.html
- Port 5090 (TCP) for the 3CX Tunnel (if you plan to use the tunnel for remote extensions)
- Port 9000-9003 (or higher) (UDP) (send & receive) for RTP communications, which contain the actual call. Each call requires 2 RTP ports, one to control to call and one for the call data. Therefore, you must open twice as many ports as you wish to support simultaneous calls via the VOIP provider. For example, if you want to allow 4 people to make calls via the VOIP provider simultaneously, you must open port 9000 to 9007.

Note that the above port ranges are the default ports in 3CX Phone System. You can adjust these ports from the Management Console, in the General > General Settings page. In this page, you can configure the ports to be used for internal calls, and the ports to be used for external calls being made via a VoIP provider.

Firewall installed on the 3CX Phone System machine

If your phone system is running on the internal network behind a firewall, it is not necessary to enable the firewall on the machine running 3CX Phone System. However if you wish to do this, then you will have to open the following ports:
- Port 5481 (TCP) for the 3CX Phone System management console
- Port 5060 (UDP) for the SIP server
- Port 5090 (TCP) for the 3CX Tunnel (if you plan to use the tunnel for remote extensions)
- Port 7000 to 7500 (UDP) for internal calls (or higher if you have more then 250 extensions).
- Port 9000-9003 (UDP) for external calls via a VOIP provider. Each call requires 2 RTP ports, one to control the call and one for the call data. Therefore, you must open twice as many ports as you wish to support simultaneous calls via the VOIP provider. For example, if you want to allow 4 people to make calls via the VOIP provider simultaneously, you must open port 9000 to 9007.

Note that the above port ranges are the default ports in 3CX Phone System. You can adjust these ports from the Management console.

Installing the 3CX VOIP Client

The 3CX VOIP Client is a small Windows application that allows you to make and receive calls via your desktop phone or using a headset connected directly to your computer. You can see the extension numbers of other users and whether they are available to take calls. Important is that you can use the 3CX VOIP client without having to use the headset: you can continue to use your desk based phone if you prefer.
The 3CX VOIP client ships with all editions of 3CX Phone System, including the free edition. However, in the Small Business, Pro and Enterprise editions, the 3CX VOIP client allows you to see the presence of other users on the phone system. In the FREE edition, other extensions appear grayed out.

The VOIP Client is very easy to deploy. To install it:

1. Ensure that you have created the extension that you wish to use with 3CX VOIP client in 3CX Phone System first. Take note of your extension number and PIN assigned to you.
2. Download the latest version of the 3CX VOIP client here.
3. Install 3CX VOIP Client by double-clicking on 3CXVOIPclient.msi. Follow the instructions and choose an installation location.

**The 3CX VOIP Client User manual**

For 3CX Phone System extension users, there is a special manual which explains the use of 3CX VOIP Client, as well as how to retrieve voice mail by phone. The latest 3CX VOIP Client manual can be downloaded here:

3. Creating Extensions

Introduction

After you have installed 3CX Phone System, you will need to follow a number of steps to complete the setup:

1. Create 3CX Phone System extensions.
2. Configure software and/or hardware SIP phones.
3. Configure phone lines.

To get started, start-up the 3CX Management console from the 3CX program group, or point your web browser to the Management Console by entering the name of the machine on which 3CX Phone System is installed, followed by port 5481. (For example: http://phone-system:5481).

A login page will appear. Enter the Username and Password that you provided during setup, select the language you would like to use and then click on the ‘Login’ button.

The 3CX Phone System Management console will appear. The screen is divided in 2 main sections:

- A left hand menu which includes the most important configuration sections, including Extensions, Lines, Outbound rules, Advanced and General.
- A right hand section which lists the configuration/management options for the selected configuration option.

The first time you start-up the management console it will show you a screen with the steps you still need to perform to get 3CX Phone System up and running. The second time you start-up the Management console, after you have created the extensions, it will display the line status of all extensions and external lines.

Adding Extensions

To add an extension, click ‘Add’ in the Extensions section. This will bring up the ‘Add Extension Page’.
User and Authentication information

Now enter the following information:

1. User information.
   - Extension number
   - First name
   - Last name
   - Email address (Optional) – This will be used for voice mail notifications and as the default SIP ID. You can leave the field empty if you wish.

2. Authentication.
   Specify an authentication ID and password.
   - ID – The SIP ‘Username’, e.g. 200.
   - Password – The SIP Password (password can be hidden from the user).

The Authentication ID and password fields set in the software or hardware phone must match the above fields! In addition the extension number must be entered in the phone as well in a field called Account, User ID or something similar to that. The exact field names differ per vendor. For detailed configuration guides for popular phones see [http://www.3cx.com/sip-phones/index.html](http://www.3cx.com/sip-phones/index.html)
Phone provisioning

Screenshot 3 – provisioning a phone

3. Phone provisioning – 3CX Phone System commercial editions can automatically provision supported phones. Essentially, after you have configured an extension, 3CX will prepare a configuration file, and publish it via HTTP. The phone will be configured to retrieve its configuration from the 3CX Phone system HTTP server and automatically configure itself. For more information how this works, see http://www.3cx.com/support/provisioning.html

To provision a phone, simply enter the MAC address of the phone (which can be found at the bottom of the phone), in the MAC address field. Then select the appropriate phone model and the Network interface (in case your phone system has multiple network interfaces)

4. Optionally specify any BLF fields that must be automatically provisioned too. Match a BLF button with an extension, so that this button will show the status of that extension. The number of available BLF buttons varies per phone. (BLF is not yet supported on Linksys phones)

Voice mail configuration

5. Voice mail Configuration.

- Enable voice mail – allows you to enable voice mail for the extension/user
- Play Caller ID – the voicemail system will play the number of the caller who left the voice message
- Read out date/time of message – the voicemail system will play back the time of the voice message to be played
• PIN number – this pin number is used to protect the voice mailbox and is used by the user to access the mailbox. The PIN number is also used as a password to logon to 3CX VOIP Client.

• Email options – You can choose the following e-mail options when a voice mail arrives:
  o No email notification – The system will not send any emails
  o Send email notification only – This option will notify the user that there is a new voice mail. However the e-mail will not contain the voice mail, the voice mail will have to be retrieved via the phone.
  o Send vmail as attachment – This option will send an email and attach the voice mail as a WAV file to the e-mail. It will still leave the voice mail in the voice mail box just in case you wish to pick up the voice mail via the phone (by dialling 999).
  o Send as attachment and delete from mbox – will send an email with the voice mail attached AND delete the voice mail from the voice mailbox on the 3CX server. This avoids the user having to delete the voice mail from 2 locations, i.e. from the email inbox and from the 3CX voice mailbox.

**Configure extension behaviour on busy, no answer etc.**

Configure when calls should be sent to voice mail in the Destination Unreachable / Forwarding section of the extension. Calls can be sent to voice mail when an extension is busy, a call remains unanswered or when an extension is unregistered.

![Screenshot 4 - Destination unreachable configuration](image)

6. Destination Unreachable / Call forwarding

You can configure per extension what the phone system should do if the extension does not answer the call, is busy or is unregistered. In the case of No Answer you have to specify the time in seconds that you want the system to wait. In the case of busy, you have to specify whether you want the phone or the PBX to do the busy signaling. By default, most SIP phones do not give a busy signal back, but accept a second incoming
call. If you want to redirect a call when an extension is busy, you will need to specify “Use PBX status” in the busy detection list box.

You have the following re-direction options;

- Continue ringing – the system will do nothing.
- End Call
- Forward to voice mail
- Forward to extension – Specify the extension to forward to in the list box.
- Forward to Queue/ ring group – Specify the virtual extension number of the ring group or Queue in the list box
- Forward to Digital Receptionist – Specify the virtual extension number of the digital receptionist in the list box.
- Forward to Outside number – In this case the system will forward the call to an outside number. Be sure to include the complete dial string including the prefix.

The Forward all calls option is used when a user is temporarily out of the office, for example on holiday.

7. Configure other options:

- It’s possible to change the user status and queue status – these settings correspond to the settings in 3CX VOIP Client.
- SIP User ID – If you wish to allow people to reach you from any SIP phone in the world using a friendly name such as sarahjones@mycompany.com, enter your SIP ID here. SIP User ID requires additional DNS configuration. For more information how to set this up, see this FAQ: http://www.3cx.com/support/sip-dns-configuration.html

Once you have filled out all necessary fields, click on the ‘OK’ button to create the new extension.

**Configuring the SIP phones**

After you have created the extension, a summary page will appear, which shows the information that the SIP phone will need:

- Proxy server IP or FQDN: **Host name of 3CX Phone System**
- User ID: **Extension number created**
- Authentication ID: **As specified in Authentication ID field**
- Password: **As specified in Authentication password field**

This information can be entered into the phones manually, or can be provisioned to the phone. Links with step by step guides how to configure popular phones (manually or via provisioning) are listed underneath.
Manual SIP phone configuration

Unless you use phone provisioning, the above information needs to be entered into the SIP phone. For the latest configuration guides how to manually configure your phone, go to: http://www.3cx.com/sip-phones/index.html

Automatic SIP Phone configuration using provisioning

Note: Phone provisioning is not available in the Free edition

If during creation of the extension you have entered the phones MAC address, a provisioning file will be created for the phone model you specified. Now all you need to do is configure the phone to retrieve this file from the 3CX Phone System server. For the latest configuration guides how to configure your phone to retrieve the provisioning file, go to http://www.3cx.com/sip-phones/index.html

Testing your setup

As soon as you have created at least 2 extensions, and configured SIP software and/or hardware phones to work with those extensions, you can test whether your setup is working correctly. To do this:

1. Check Phone System status with the status monitor

![Screenshot 5 - The Status monitor](image)

Load up the 3CX Phone System Management console, and click on Phone System > ‘Line Status’ (This is the default page). Check that all extensions are listed and are ‘On Hook’.

The status monitor shows the status of your extensions and any external lines. It is the default screen when you load up the management console after having configured the extensions. The following states are displayed:
• **Not registered** – The extension has been created, however the phone has not registered itself with the system. This could be because the device is off, or because the SIP credentials are incorrect. Another cause could be that you have a firewall enabled on the machine running 3CX Phone System and that it is blocking communications between the server and the phone.

• **Registered (idle)** - The extension is registered and ready for phone calls.

• **Calling** – The extension is dialling a number

• **Ringing** – The extension is ringing

• **Connected** – The extension is currently on a call

• **Holding** – The extension has placed a call on hold

• **On Hold** – The extension is party to a call that has been placed on hold

**2. Place a call to another extension**

If the status shows that the phones have registered correctly, you can make a call to another extension. The status monitor will show that you picked up one extension and are calling another.

**3. Troubleshooting tips**

If dialling another extension does not work, check the following:

• That you have created the extensions and configured the phones with the same authentication details and that they have registered. If they have not registered, you have most likely entered the Extension Number, Authentication ID and Authentication Password in the wrong fields.
Click on **Phone System > Server status** to bring up the server status screen. This screen shows the activity log of the server. Often these messages can give you further information on what the problem is. A detailed description how to understand the server status messages can be found in the support section of the 3CX website.

- Check your Firewall configuration! Switch off the firewall temporarily to check if the problem is caused by the firewall.

**Importing extensions**

If you need to create a large number of extensions it is handier to bulk import the extensions. To do so follow these steps:

1. Create a spreadsheet with columns for each field, in the following order: 1. Extension number, 2. first name, 3. last name, 4. authentication id, 5. authentication password, 6. outbound caller ID, 7. email address

2. Now list all the extension numbers, user names, authentication ID and password and other optional fields on separate lines. After you have entered all the desired extensions, save the file as a “CSV (Comma Delimited)” file.

3. In the 3CX Phone System Management Console, go to the “Manage” page under the “Extensions” section. Click on the “Import Extensions” icon to load up the ‘Import extensions’ page. Click ‘Browse’ and select the file previously created. Click on the ‘Import’ button to import and create the extensions.
4. Adding PSTN line(s) via a VOIP Gateway

Introduction

External calls are received and made on PSTN phone lines. A traditional PBX requires you to connect the PSTN lines to the PBX hardware box; however in the case of 3CX Phone System you have more options:

- Connect PSTN lines (physical phone lines) to a VoIP Gateway situated on your internal network.
- Use a ‘hosted’ phone line from a VOIP Service Provider. In this case the VOIP service provider has connected external lines to a VOIP Gateway and allows you to access these lines via your internet connection.

To make & receive external phone calls via your regular phone lines, you will have to buy and configure a VoIP gateway. This chapter explains VoIP Gateways and how to configure them.

What is a VoIP Gateway?

A VoIP gateway is a device which converts telephony traffic into data, so that it can be transmitted over a computer network. In this manner PSTN/telephone lines are “converted” to SIP extensions, allowing you to receive & place calls via the regular telephony network. VOIP Gateways exist for analog lines as well as BRI, PRI/E1 lines and T1 lines.

There are lots of VoIP gateways available today at competitive prices. Analog VOIP gateways start at as little as $100. Be sure to use a supported gateway - a list of supported gateways can be found on http://www.3cx.com/voip-gateways/index.html.

VOIP Gateway configuration overview

Just as it is necessary to configure a phone to register with the phone system, it is necessary to configure the VoIP gateway to register its lines with 3CX Phone System. Each line gets a SIP user ID & Password, and to the IP PBX, the PSTN line appears just like any other SIP extension.

In the next sections we will now describe step by step how to configure a VOIP Gateway for use with 3CX Phone System.

Step 1: Create the PSTN lines in 3CX Phone System

The first step is to create the PSTN lines in the 3CX management console. Each PSTN Line will become a virtual extension and be assigned a virtual extension number, authentication ID and authentication password. To add PSTN lines to the 3CX phone System;
1. In the 3CX Phone Management console click on the ‘Add PSTN’ link in the left hand menu.

2. In the name field, enter a friendly name for the VOIP gateway. Now choose the gateway model that you are using from the list. If it is not listed, select generic. Note that we will not be able to support you in using this gateway. Now click “Next”.

3. Enter the host name or IP of the VOIP Gateway in the ‘Gateway Hostname or IP’ field, and specify the SIP Port on which the gateway is operating. By default this is 5060.
4. Specify the number of ports that the gateway supports and whether you are using Analog lines, BRI, PRI or T1 lines. This will set up one account for each port and enable the corresponding number of lines for that account. An analog line supports 1 call; a BRI port supports 2 calls, an E1 (PRI) 30, and a T1 (PRI) 23. For example, if you specify 1 * T1 port, it will create one SIP account which can handle up to 23 lines. If you wish to have each line individually addressed, simply select 23 * Analog lines.

5. The other options, such as Registration Settings, Other options etc. have been preconfigured for your gateway model and do not need to be changed. Click Next to go to the next screen.
6. Click Next. The individual lines/ports will be ‘created’ and displayed in a columnar format.

**Virtual extension** – In effect the VOIP Gateway “converts” each line/port to an extension, so that the phone system can receive and forward calls to it. The virtual extension number is a number assigned to it by 3CX Phone System so that it can address it as an extension. There is no need to change this field.

**Authentication ID & Password:** These values are used to authenticate the phone lines connected to the VOIP Gateway with 3CX phone system. **These values must match the settings configured in your gateway!** By default the ID and password have been set to the Virtual extension number.

**Channels:** The Channels field allows you to specify how many simultaneous calls this port supports. An analog line supports 1 call; a BRI port supports 2 calls, an E1 (PRI) 30, and a T1 (PRI) 23. If you prefer to address each line individually, you can create additional SIP accounts and change the number of channels supported by each account to 1. Note that your VOIP Gateway must support this – especially higher density VOIP Gateways are easier to configure if you use one account for all lines connected to a port.

**Direction:** This field specifies whether the port will be used for inbound calls, outbound calls or both. By default it supports both ‘directions’.

**External Number** – This field specifies the actual PSTN phone line number and is used for identification purposes only.
**Route:** If the line/port will receive inbound calls, you can specify to which extension, ring group or digital receptionist a call must be routed. You can specify a different option depending on whether the call is received inside or outside office hours.

If your gateway supports T38 faxes, you can have fax calls automatically routed to the inbuilt T38 Fax server service. This will receive the fax and forward it as a PDF attachment to the email address of a particular extension. Select the extension to have it sent to the email address of that extension. If you select Default virtual fax number, the fax will be sent to the email address configured for the virtual fax extension number (this can be configured in General > general settings).

7. When done click finish to create the lines. You can change line options of lines that have been created by going to the Lines > Manage page.

8. On the next page, you will be asked for a prefix so as to create an outbound rule for this device. Tick the “Create outbound rule” check box and enter the dialling prefix in the “With prefix” text box. To make calls via this provider, precede the number to be dialled with this prefix.

---

**Step 2: Configure the VoIP gateway**

After you have created the PSTN Lines/ports, a summary page will appear, which shows the information that you need to enter into the VOIP Gateway:

- **Proxy server IP or FQDN:** Host name of 3CX Phone System
- **User ID:** Virtual Extension number
- Authentication ID: **As specified in Authentication ID field**
- Password: **As specified in Authentication password field**

The Virtual extension number, authentication ID and authentication password must be duplicated for each line/port that you have on your gateway.

**For a detailed description how to do this for popular gateways, follow the configuration guides listed on last page of the configuration wizard, or go to:** [http://www.3cx.com/voip-gateways/index.html](http://www.3cx.com/voip-gateways/index.html)

**Generating a configuration file**

For some gateways, 3CX Phone System is able to create a configuration file that can be uploaded to the device and makes configuration automatic. In this case, the button ‘Generate configuration’ will be active. Clicking the button will generate a text based configuration file which can then be uploaded to the device using the web based interface of the device.

**Configuring the PSTN Interface**

In some cases you might need to check that the PSTN interface is configured correctly for your country. If in doubt, check with the VOIP Gateway supplier. For example if you have bought a device that is configured for the US but you are using it in the UK, you might have issues such as the device not detecting a hang up by a caller. In these cases you will have to configure the Call Progress Tones for the VOIP Gateway. For more information about this consult the VOIP Gateway supplier and manual.
5. Adding lines hosted by a VOIP Provider

**Introduction**

VOIP providers "host" phone lines – they can assign local numbers in one or more cities or countries and route these to your phone system. In addition, VOIP providers are often able to give better call rates because they have an international network or have negotiated better rates. Therefore, using VOIP providers can reduce call costs. However, be aware that each VOIP call requires bandwidth. VOIP is real time, so it does place a demand on your internet connection. As a rule of thumb, each call will consume approximately 30k-120k per second, depending on which codec you use. This chapter describes with which VOIP providers you can set-up an account and how to configure 3CX Phone System accordingly.

**Requirements for using a VOIP provider**

If you plan to use a VOIP provider, you will have to have a firewall/router/NAT device that supports **STATIC PORT MAPPINGS**. Often routers will perform port address translation, which will cause problems such as one way audio, failing inbound calls and so on. It is also highly recommended that you have a **static external IP**. If your external IP changes at certain intervals, inbound calls will fail. Please see our support FAQ for more information and sample router configurations.

**Step 1: Create an account with a VOIP Provider**

To add a VOIP line you need to have an account with a quality VOIP service provider. 3CX Phone System supports most popular SIP based VOIP service providers and we recommend using one that has been tested by 3CX. 3CX includes pre configured templates for these VOIP providers. Simply click on the ‘Add VOIP’ link to see a list of supported gateways.

*Note that you can use any SIP based provider but we will not be able to support you in the configuration of the VOIP provider, nor can we guarantee that it will work. Therefore, unless for your country no VOIP provider is listed, use a supported VOIP provider.*

Note that Skype has a proprietary protocol and is therefore currently not supported.

**Step 2: Add the VoIP provider account in 3CX Phone System**

After you have created the VOIP provider account, you will need to configure the account in 3CX Phone System. To do this:

1. In the 3CX Phone Management console click on the ‘Add VoIP’ link in the Lines section in the left hand menu.
2. In the name field, enter a friendly name for this VOIP provider account and choose the VOIP provider that you are using. If it is not listed, select 'Generic VOIP provider', or 'Generic SIP Trunk'. A generic SIP trunk is a provider that does not use an authentication ID and password, but rather uses your IP as authentication. If using a generic provider we will not able to guarantee that it will work with this VOIP provider. Now click Next.

3. The registrar/Proxy Hostname will be pre-filled. Compare these with the details that you have received from your VOIP provider and check that these are indeed correct. Depending on the VOIP provider that you are using, some fields will be disabled. This means you do not need to change them. You do not need to change any of the options included in the other sections. Click Next to continue.

4. Now enter the VOIP provider account details. In the VOIP External number field, enter the VoIP line number that has been assigned to. Then enter the Authentication ID/user name and password of your VOIP provider account. You can configure how inbound calls should be routed in the 'Route inbound calls section'. You do not need to change any of the other options included in the other sections. Click Next to continue.

5. 3CX Phone System will now perform a firewall check. 3CX will connect with a public 3CX firewall check server (firewallcheck.3cx.com) and will check that it can send and receive UDP data on port 5060 (for SIP), port 3478 (for STUN) and port 9000 to 9016 (for up to 8 simultaneous calls, default setting). If it can, the firewall check will succeed. If it does not, the firewall check will fail and you will have to edit your firewall configuration. You can skip the test and modify your firewall configuration later, but
you will not be able to make or receive calls via this provider until you pass the firewall check.

6. On the next page, you will be asked for a prefix so as to create an outbound rule for this VOIP provider. Tick the “Create outbound rule” check box and enter the dialling prefix in the “With prefix” text box. To make calls via this provider, precede the number to be dialled with this prefix.
6. Creating Outbound Call Rules

Introduction

An outbound rule defines on which gateway/provider an outbound call should be placed, based on who is making the call and the number that is being dialled and the length of the number.

Creating an outbound call rule

To create an outbound rule:

1. Click on ‘Add Rule’ in the Outbound rules section of the 3CX Management console. Give a name to the rule in the general field.

2. Now specify to what calls to apply the outbound route. In the ‘Apply this rule to these calls’ section, specify any of these options:

**Screenshot 12 - Creating a new outbound rule**
• Calls to Numbers starting with – apply this rule to all calls starting with the number you specify. For example, specify 0 to specify that all calls starting with a 0 (usually a prefix) are outbound calls. Callers would dial '0123456' to reach the number '123456'.

• Calls from extension(s) – Select this option to define particular extensions or extension ranges for which this rule applies. Specify one or more extensions separated by commas, or specify a range using a '-', for example 100-120.

• Calls with a Number length of – Select this option to apply the rule to numbers with a particular digit length, for example 8 digits. This way you can capture calls to local area numbers or national numbers without requiring a prefix.

3. Now specify how the outbound calls should be made. In the 'Make outbound calls on' section, select up to 3 routes for the call. Each defined gateway or provider will be listed as a possible route. If the first route is not available or busy, 3CX Phone System will automatically try the second route.

4. You can transform a number that has been ‘caught’ by the outbound rule before it is routed to the selected gateway or provider using the ‘Strip digits’ and ‘Prepend’ fields:

• Strip digits – allows you to remove 1 or more of the digits. Use this to remove the prefix before it is dialled on the gateway or provider. In the example above, you would specify to remove 1 digit, in order to remove the prefix '0' before it is dialled.

• Prepend – allows you to add one or more digits if needed by the provider or gateway.

You can set these options per route, since a VOIP gateway connected to the local PSTN might require a different logic than if the call is routed via a VOIP provider.

Manage outbound call rules

To manage outbound rules, click on Outbound Rules > Manage in the 3CX Management console. This brings up the list of the rules and shows you at a glance how outbound calls are routed. You can configure the priority of a rule by moving the rules up or down in the list.
7. The Digital Receptionist / Auto attendant

**Introduction**

The digital receptionist feature allows you to answer phone calls automatically using the computer and present the caller with a list of options. The caller can then choose the appropriate option using the numbers on his phone key pad.

Using this feature you can implement a menu, for example: “for sales press 1, for support press 2 etc”. A digital receptionist is also known as an auto attendant.

You can configure different menu options and text for the menus based on which line the calls comes in, as well as based on whether the call is received within or outside office hours. This way you could have a different answer outside office hours and de-activate menu options accordingly.

**Recording a menu prompt**

Before you create your digital receptionist, you must write down the menu options you wish to offer the caller, think of a suitable text and record the announcement. A simple example would be “Welcome to Company XYZ, for sales press 1, for support press 2 or stay on the line for an operator”

*Note: It is generally recommended to put the number the user should press after the option, i.e. “for sales, press 1”, rather then “press 1 for sales”. This is because the user will wait for the desired option and only then “register” what number to press*

Once you have devised the text you can create the prompt and save the file in wav or mp3 format. For best performance, it is best to save the prompt in **PCM, 8 kHz, 16 bit, Mono** format. Windows Sound Recorder supports creation and conversion of this format.

**Recording the prompt in Windows Sound Recorder**

To record the prompt in Windows Sound Recorder:

1. Start Windows Sound Recorder from the Start > Programs > Accessories > Entertainment group. This program should be installed by default on Windows.
2. Now click the record button to record your system prompt.

3. Now save the file using the ‘Save As’ command. This allows you to specify the format to save the file in. Click on the ‘Format’ button to change the format to PCM, 8 kHz, 16 bit. Enter a name for the prompt and click save.

4. When creating a digital receptionist menu you will be asked for the path to the file.

   Note: You can also have your voice prompts professional recorded using a Voice Talent studio. Be sure to have them created in the specified format.

Creating a digital receptionist

You can create multiple digital receptionists and link them to a particular line. To create a digital receptionist:

1. In the 3CX Phone Management console click on the ‘Add Receptionist’ link in the left hand menu. The ‘Digital Receptionist’ screen appears.
2. Specify a name and virtual extension number for the digital receptionist.

3. Now click on the browse button and specify the file that you previously recorded. The file will be copied into the 3CX Phone System\Data\Http\prompts\ directory.

4. Specify the menu options. Select the appropriate key, and then select from the available actions. Then specify the extension number or virtual extension number (virtual extension number in the case of Ring Group, Call Queue or to another Digital receptionist)

5. The last option, Timeout, allows you to specify how long the system should wait for an input. If it receives no input, it can automatically perform an action. This is handy for callers who did not understand the menu or who do not have a DTMF capable phone. When you are ready, click OK to save the digital receptionist.

**Allowing callers to dial a known extension directly**

Whilst a digital receptionist prompt is playing, a caller can enter the extension number directly to be connected to an extension immediately. This allows callers who know their parties extension to avoid bothering the receptionist.
This option is enabled by default. If you wish to make use of this feature simply instruct your callers by explaining this in the voice prompt. For example:

“Welcome to Company XYZ, for sales press 1, for support press 2. If you know your parties extension number, you may enter it now”

**Call By Name**

You can also direct callers to the dial by name function. This allows them to find the person they wish to speak to by entering the first letters of the persons name on the phone dial pad.

Requirements:
To call to a user using the call-by-name mechanism you have to:

1) Define a self-identification message for the user. Users without a self-identification message are not accessible via call-by-name mechanism.
2) User has to have the last name without Unicode characters
3) Call-by-name menu dialog can be activated from any Digital Receptionist as an action on key pressing or timeout.

**Self-identification Message**

To enter self-identification message:

1) Activate Special Menu for your extension.
2) Go to the options menu (‘9’ key).
3) Press ‘5’ key.

If you do not have self-identification message yet, then you will hear “Record your self-identification message, then press pound”. If you already have a self-identification message, then you will hear “To record new self-identification message press zero. To delete message press one. To exit press pound.”

**Calling**

Call-by-name mechanism uses the last name of the user to compare with call-by-name input (that has been entered from phone keypad). The following rules are used:

- The last name is converted to upper case.
- All symbols except [2-9] and [A-Z] are ignored.
- The following translations for symbols is used:
  o ‘ABC2’ => ‘2’
  o ‘DEF3’ => ‘3’
  o ‘GHI4’ => ‘4’
  o ‘JKL5’ => ‘5’
You have to type a minimum of three digits ('0' – '9') to call to a user. Digits '0' and ‘1’ are ignored, but can be used to call to users with short last names (for example, to access someone with the last name 'Li', you can type '540').

After the user has entered three digits, IVR queries the phone system database for matching users. If there are no matching users, then it plays “extension not found”. If there is only one matching user, then the IVR plays “Please hold while I’m calling to <user’s self-identification prompt>” and redirects the call to the user. If there is more than one matching user, than IVR waits for additional digits from user for 2 seconds.

If IVR waits for additional digits (more than one matching user) and user press any digit, then IVR adds this digit to the current input and checks currently matching users. If there are no matched users, then it plays “extension not found”. If there is only one matching user, then the IVR plays “Please hold while I’m calling to <user’s self-identification prompt>” and redirects the call to the user. If there is more than one matching user, than IVR waits for additional digits from user during 2 seconds.

If user terminates input (2 seconds elapsed or ‘#’ has been pressed) and more then one user is matching, then IVR will play something like: “To call to Van Damme press 0. To call to Van Hallen press 1. To exit press pound”. Here ‘Van Damme’ and ‘Van Hallen’ are self-identification prompts of the corresponding users.
8. Adding Direct numbers using DID/DDI lines

Introduction

Many companies provide users and/or departments with “Direct or DID numbers”, which allow their contacts to call them directly, bypassing the receptionist. DID numbers are referred to as DDI numbers in the United Kingdom and as MSN numbers in Germany. Even if you have a digital receptionist, a direct line / number is often preferable because it’s more convenient for the caller.

Direct numbers can be easily implemented using DID numbers. DID numbers are provided by your VOIP provider or Phone Company and are virtual numbers assigned to your physical lines. Usually you are assigned a range of numbers, which is linked to an existing BRI/T1/E1. There will be an extra charge per number or per range, but this will be a fraction of the cost of adding physical lines. VOIP providers also provide DID lines. Enquire with your Phone Company or VOIP provider for more information.

DID numbers and 3CX Phone System – How it works

DID numbers “play well” with 3CX Phone System, or indeed with any SIP based IP PBX. Acting according to the SIP standard, 3CX Phone System expects the DID number, i.e. the intended destination, to be in the To: field of the SIP invite request. Most VOIP providers and VOIP Gateways will do this by default.

If your VOIP Provider and VOIP Gateway do this by default, all you need to do in the 3CX Management Console is setup a DID Line (which is akin to an inbound rule) to configure calls made to that particular DID number to go to a particular extension, digital receptionist or other destination.

Adding a DID line

To add a DID line to 3CX phone System;

1. In the 3CX Phone Management console click on the ‘Add DID’ link in the left hand menu. The ‘DID/DDI configuration’ screen appears.
1. Enter the DID number as it will appear in the SIP “to” header. 3CX Phone System will match the number inserted in this field with the “to” header, starting from the last part of the received string, thus avoiding any differences in the format of the number. For example, if you are based in the UK and your DID number is 0845-2304024, then you can enter the number 2304024. This will match any DID number inserted in the “To” field ending with these numbers, including +448452304024, 08452304024, 00448452304024, and, of course, 2304024. Of course it is best to check with your VoIP provider or Phone Company in what format the DID number will be inserted just for reference.

Another way of finding out the exact number that is inserted in the “To” field is by viewing the server status log and seeing the “To” field assigned by the VoIP Provider / Gateway and then adjusting the DID line number accordingly.

3. In section “Source”, select the Gateway or Provider which provides the DID number (i.e. from which the call will originate). This field is optional but adds a level of security, since otherwise 3CX Phone System will accept calls to that DID number from any source. If you are not using a VoIP provider but only a VoIP Gateway, you could leave this field unchecked.

4. In the next section you can specify where calls to this DID line should be routed to:

**Route inbound calls in office hours:**
This section allows you to specify how an inbound call should be routed during office hours. You can choose to route inbound calls to a:

- **Digital receptionist** – Select the digital receptionist from the drop down list of configured digital receptionists (note that digital receptionists are not available in the beta version).
- **Extension** – Select the extension from the drop down list of available extensions.
- **Ring group** – Select the ring group from the list of available ring groups.
- **Queue** – Select the queue from the drop down list of available queues (Enterprise edition).

**Route inbound calls out of office hours:**

You can specify that an incoming call is routed differently if it is received outside office hours. You can select from the same routing options. Click on the ‘Specify Office Hours’ button to define your office opening hours.

**Route FAX**

If one of your numbers is a fax line, you can configure the DID of this line to forward to the 3CX Fax Server. The Fax Server will receive the fax, convert it to a PDF and forward it to the email address of the specified extension.

**Screenshot 8- Configure where to email faxes**

If you select “Default FAX Destination”, the fax will be sent to the email address configured for the virtual fax extension number. The default virtual fax number email address is configured from the ‘General settings’ page in the General section.

**Troubleshooting DID lines**

If you have created DID lines, but calls are not being forwarded, its best to do the following:

1. Go to the Server Status screen in the 3CX management Console. The Server Status screen lists current server activity and logs calls that are being received and for which number they were received.

2. Call the DID number that you configured, and monitor the Server Status log. You will see a line appearing something like:

   ```
   Incoming call from 1000 to <sip:789456123@3CXPhone System>
   ```

   where “1000” is the internal number of the line configured to receive calls from the VOIP Gateway or VOIP Provider and `<sip:789456123@3CXPhone System>` is the content of the “To” header of the INVITE, i.e. the intended recipient.
3. Now analyze the “To” header carefully and ensure that the DID number you have
dialed is present in the “To” header: <sip:789456123@3CXPhone System>.

4. If the DID number is not present in the “To” header, you will have to check the
documentation of your VOIP Gateway to find how you can configure it to insert the
DID number into the “To” field. In the case of a VOIP Provider, contact your VOIP
provider for more information.

5. If the DID number is present in the “To” header, check whether the string listed in the
“To” field matches the string you configured in the rule. Adjust accordingly and try
again.
9. Ring groups, Call Queues, Paging / Intercom

Ring Groups

A ring group allows you to direct calls on particular numbers to a group of extensions. For example, you could define a group of 3 sales people, and have the general sales number ring on all 3 extensions at the same time or after each other. When you create a ring group, you also assign it a virtual extension number. This will be the number used by the phone system to “address” the ring group.

Screenshot 16 - Adding a ring group

To add a ring group:

1. Click on the Advanced > Add Ring Group link to bring up the ‘Add Ring Group’ page.
2. Now enter the ring group options:
   - Virtual extension number – Specify an extension number which will be reserved for this ring group. Note that this extension number will be automatically created. Do not specify an existing extension number.
   - Name – Enter a friendly name for the ring group
Ring strategy – Select the appropriate ring strategy for this ring group:

- **Hunt** – this will start ringing on the first extension, then the second etc.
- **Ring all** – all phones will ring at the same time
- **Paging** – this will page all extensions part of the group (see next section)

Ring time – Specify how long the phones should ring for.

3. In the section ‘Ring group members’ specify the extensions that should be part of this ring group. Simply click on the extensions and click on the -> to make them a member. Move the extensions up or down to configure the priority of an extension.

4. In the section ‘Destination if no answer’, you can define what should happen if the call does not get answered by the ring group.

**Paging / Intercom (Paid editions only)**

Paging allows some one to ring a group of extensions and make an announcement via the phone speaker. The called party will not need to pick up the handset. The connection will be one way audio.

The intercom feature allows a phone system user to make an announcement to a single extension. In this scenario the audio is two way, and the called party can respond immediately without picking up the handset.

Both paging and intercom features require a phone that supports intercom and that is configured to allow it. See the phone configuration guides for more information.

To add a paging group:

1. Click on the Advanced > Add Ring Group link to bring up the ‘Add Ring Group’ page.

2. Now enter the ring group options:

   - **Virtual extension number** – Specify an extension number which will be used for this paging group.
   - **Name** – Enter a friendly name for the ring group
   - **Ring strategy** – Select the Paging ring strategy

3. In the section ‘Ring group members’ specify the extensions that should be part of this paging ring group. Simply click on the extensions and click on the -> to make them a member.

   Note, The ‘Ring time’ and ‘Destination if no answer’ options will be ignored, since they are not relevant for paging.

To call a user via the intercom function:

Prefix the extension you wish to call with *9, followed by the extension. For example to make an intercom call to extension 100 you should dial:

"**9100"
Call Queues (Paid editions only)

Call Queues allow calls to be queued whilst agents (members of a call queue) answer calls. Calls do not go unanswered but are queued until an agent is available to take the call. For example, you can define a group of 3 sales people, and have the general sales number route to a sales call queue. If all 3 sales people are busy, callers will be kept on hold until the next sales person is free. When you create a call queue, you also assign it a virtual extension number. This will be the number used by the phone system to “address” the Call Queue.

To add a Call Queue:
1. Click on the Advanced > Add Call Queue link to bring up the ‘Add Call Queue’ page.
2. Now enter the call queue options:
   - Virtual extension number – Optionally change the suggested virtual extension number. Note that this extension number will be automatically created. Do not specify an existing extension number.
   - Name – Enter a friendly name for the ring group
   - Ring time – Indicate the time out, i.e. for how long the phone should keep ringing before it considers the call unanswered by that agent.
3. In the section ‘Call Queue agents’ specify the extensions that should be part of this Call queue. Simply click on the extensions and click on the -> to make them a member. Move the extensions up or down to configure the priority of an extension.

In addition to being a member, an extension/user must also login to start answering calls routed to this call queue. Users can login to a call queue using the login button in the VOIP Client.

4. In the section ‘Destination if no answer’, you can define what should happen if the call does not get answered by the Call queue.

5. In the section ‘Other options’, you can specify a custom introduction prompt and a custom music on hold file. You can also decide whether you wish to announce a caller’s position in the queue and what the maximum wait time should be.
10. Call conferencing

Introduction

Note: This feature is not present in the free edition of 3CX Phone System

Call conferencing allows you to easily setup up to 8 conference calls that can allow a total of 32 callers (license permitting). In other words the 32 caller limit is for all conferences, not per conference. Note that a conference with 32 participants will require a powerful machine.

Although many conference call services exist, it’s often easier and cheaper to host your own audio conferences.

Conferences can be set-up ad hoc, without the need to reserve a conference room. This has been done to simplify the set-up of conference calls.

Enabling conferencing

The conferencing service does not require much configuration – you just need to specify the default conference extensions. To do this:

1. In the 3CX Management console, go to General > General Settings > Conferencing server.
2. Now specify the conferencing extension number. This is the number that users must call to setup a conference.
3. Specify the maximum number of conferences you wish to support. By default 4 conferences can be held at a time.

Creating a call conference

To setup a call conference;

1. Dial the conference extension number, by default this is 700
2. You will be requested to enter a conference ID. This can be any number, for example ‘100’. All callers that wish to join the conference must use the same conference ID!
3. If you are the first participant, the conference system will ask you to confirm creation of the conference. Press * to confirm or # to cancel
4. You will be asked to speak your name after the beep and press a button to continue.
5. You will now enter the conference. If you are the first caller, you will hear music on hold, whilst you wait for the other callers. As soon as another caller joins, his name will be announced.
11. Generating Call Reports

Introduction to reports

Screenshot 9 - Call Reports

3CX has a separate reporting utility called 3CX Call Reporter. It allows you to analyze call logs and generate reports on your call traffic.

Installing 3CX Call Reporter

The call reports application is a separate download and can be downloaded from here:

http://www.3cx.com/downloads/3CXCXCallReporter.msi

After downloading, double-click on the setup file and follow the instructions.

Note that the following is required:

- The application must be installed on the 3CX Phone System server
- You must have Microsoft Access installed

Running 3CX Call Reporter

After you have installed 3CX Call Reporter, run the short cut from the program menu. You will have to get past 2 security warnings and then click on the open button. Then you can access the following reports from the reports menu at the top:

- Call Log Report
- Call Statistics (grouped by internal numbers)
- Call Traffic (calls statistics grouped by time intervals)

For detailed instructions, please see the manual included in the setup and available from as a shortcut in the 3CX Call Reporter menu.
12. Connecting 3CX Phone Systems

Introduction

Note: This feature is not present in the free edition of 3CX Phone System

You can connect 2 separate 3CX Phone Systems using a 3CX to 3CX bridge, allowing you to make calls between branch offices using your internet connection – and thus at no charge.

The “bridge” will be assigned a prefix, which users must dial to access the other 3CX Phone System. This prefix must be followed by the extension number of the user they wish to reach on the other 3CX Phone System. For example, if you assign the prefix “2” to a bridge with another office, and within that office you want to dial someone who has extension number 105 on that phone system, you would dial 2105 to reach that person directly.

Creating a bridge

To create a 3CX to 3CX bridge:

1. Click on the Lines > Add 3CX to 3CX bridge link to bring up the ‘Add 3CX to 3CX bridge’ page.

2. Enter a name for the bridge and assign a virtual extension number. A bridge must be assigned a virtual extension number so it can be addressed by the phone system. Accept the default or choose another extension that is free.

3. Next you need to decide whether this 3CX Phone System will act as a Master or as a slave. A slave registers with a master. If you have selected slave, you must also choose whether you want to make a direct connection, or using the 3CX Tunnel, which allows all SIP and RTP traffic to be sent via a single TCP port. The 3CX Tunnel vastly simplifies firewall configuration.

4. If you selected ‘Master’ then all you need to do is enter the authentication details which must be used by the slave to register with this 3CX Phone System.
5. If you selected to create a slave bridge, then you must enter:

- Public IP of the remote 3CX Phone System
- SIP Port of the remote 3CX Phone System
- Authentication ID and Password – The credentials with which this side of the bridge must authenticate with the ‘Master’. In other words, you will specify these credentials when creating the ‘Master’ side of the bridge.

6. If you have selected to create a slave bridge using a 3CX Tunnel, then you must enter

- Private IP or hostname of remote 3CX Phone System and port
- Remote end of the tunnel – in most cases the tunnel will be running on the 3CX Phone System machine, in which case you need to enter the public IP of the 3CX Phone System machine. Enter the SIP Port of the 3CX Tunnel (by default 5090)
• Enter the Local end of Tunnel. Leave the default ‘Localhost’ and 5080 to use the Tunnel installed by default with 3CX Phone System.

• Authentication ID and Password – Enter the credentials with which this side of the bridge must authenticate with the ‘Master’. In other words, you will specify these credentials when creating the ‘Master’ side of the bridge.

*Note: You will have to open port 5090 on the firewall behind which ‘Master’ 3CX Phone System resides.*

7. Now you must assign a prefix that users must dial to access the bridge. Click Next to create the bridge.

8. After it is created it, you can edit bridge options by going to Lines > Manage and clicking on the bridge you created. You can edit:
   • Codec priorities – to save bandwidth, we suggest using the GSM codec
   • In the section other options you can define the maximum number of simultaneous calls you will allow for this bridge and whether outgoing or incoming lines will be allowed.
   • Configure what to do with calls coming in via the bridge outside office hours

9. Now you must go to the Management Console of the other 3CX Phone System and set-up the opposite end of the bridge, i.e. either a ‘Master’ or a ‘Slave’. You must use the same authentication credentials!

**Calling a party on the other 3CX Phone System**

To dial a party at the connected 3CX Phone system, you must dial the assigned prefix, plus the extension number of the person you wish to call.
13. General configuration

Introduction

This chapter describes general configuration options of 3CX Phone System.

Admin credentials

To access the 3CX Management console, a user requires credentials. You specified these credentials during set-up. You can change these credentials as follows:

1. Click on General > Administrator credentials, to bring up the ‘Admin credentials’ page.

2. Now enter the new Administrator ID and password. Re-enter the password in the section ‘Confirm Administrator Password’.

3. Click OK to change the user ID and/or password. At the next logon to the Management console you will have to specify the new ID and password.

General Settings

The general settings page allows you to configure a number of important options, including the ports range to be used by 3CX Phone System.

SIP Port

You can customise the port on which the 3CX Phone System will be listening for SIP messages. The default port number is 5060.
Ports to use for internal calls

In this section you can enter the ports that will be used by 3CX Phone System for internal calls. These ports will be used for calls between extensions and to external numbers routed via a VOIP Gateway. (Since your VOIP Gateway will be located on your internal network, calls via the VOIP gateway are considered internal calls).

Ports to use for external calls

This section allows you to configure which ports will be used for external calls via a VoIP provider. The range you specify here must be opened on your firewall. For more information see the section ‘Firewall configuration’ in Chapter 2.

Voicemail and FAX delivery settings

The voice mail and FAX delivery settings section allows you to configure an SMTP mail server and a reply to address. This is needed in order for 3CX Phone System to send out email notifications when a new voice mail arrives for a user. Optionally 3CX Phone System can attach the voice mail as a wav file. Specify the SMTP server name or IP address and a reply to address to be used as the sender name. If your SMTP server requires authentication, enter a user name and password to use.

Special Voice Menu Extension Number: This is the number to dial for the retrieval of Voicemail. The user will be prompted to dial his extension number and pin number before obtaining access to his Voicemail.

Screenshot 23 – Voicemail and Fax Delivery Settings
STUN Server Options

You can specify a STUN server to use for external IP address resolution. You can optionally specify a custom port. The default port number is 3478. You may also adjust the interval between one check and another. The default interval is 1200 seconds (20 minutes). More information about STUN servers can be found here: http://www.3cx.com/PBX/stun-server.html

Settings for direct SIP calls

3CX Phone System includes the ability to make and receive Direct SIP Calls. 3CX Phone System can receive Direct SIP Calls (user1@mydomain.com) as well as place Direct SIP calls to Uri’s from another domain. This feature requires setting up a DNS SIP SRV record for your domain to receive inbound Direct SIP Calls. For information how to do this, check this FAQ at http://www.3cx.com/support/sip-dns-configuration.html

To enable this feature, tick the ‘Allow Calls to External SIP URI’s’ box and enter the local SIP domain you configured.

Logging Level

These settings allow you to configure the level of logging detail produced by the 3CX Phone System logging system. It is recommended to keep this setting to “Low” during normal day-to-day operations. The “Verbose” setting is a valuable tool when troubleshooting issues, but generates a large amount of data, putting greater demands on the I/O subsystem and consuming considerable storage space.
Configuring office hours

If the phone system knows your normal office hours, it can route a call differently depending on whether the call is received within or outside office hours. To configure office hours:

1. Go to the Lines > Manage page and click on the ‘Configure Office hours’ button. This brings up the ‘Set Office hours’ page.

2. In the ‘Define Holidays’ section, you can define specific dates as public holidays, so that these dates will be considered out of office hours.

3. In the section ‘Define opening days’, you can define the days that your office is open and the daily opening times. Tick the days that your office is open. Those days of the week will appear in the table. Then tick the hours that your office is open. Click ‘Save’ when done.
Phonebook

Screenshot 10 - Phonebooks for SIP hardware phones

The phonebook feature allows you to automatically provision a phonebook / telephone number list to SIP hardware phones. This phonebook list will be available then be available on the phone via the phone functions buttons.

Phonebooks for all popular phones are created automatically and store on the 3CX Phone System http server: Phones are then provisioned to read the phonebooks from this location. Currently Linksys, Snom, Aastra and Grandstream are supported.

By default, the phonebook will include all extensions created in 3CX Phone System. You can create additional entries relevant to the whole company: Simply specify name and phone number and add it to the list. After you are done, click ‘generate’ to re-create the phonebooks on the server. The phonebooks will then read the new phonebook information.

Exchange 2007 Unified Messaging Integration

Although 3CX Phone System includes its own voice mail server and auto attendant, you can configure 3CX Phone System to use the Exchange Server 2007 Unified Messaging Server as a Voice mail server instead.

To use Exchange Server 2007 as a voice mail server, you will need to configure Exchange Server 2007 as a Unified Messaging Server. For a detailed description how to do this read our online configuration guide at:


After that, you will have to enable the MS Exchange 2007 integration from the 3CX Management Console:

1. Ensure you have an Enterprise Edition of 3CX Phone System and that you have activated the license. Otherwise the fields will be greyed out.
2. Go to General settings > Microsoft Exchange Server 2007 integration. Enable the feature, and enter the IP of the machine running the Exchange Server 2007 Unified Messaging Role. If you have configured Exchange Server 2007 to run on a different port, specify the port you used. Click OK.

From now onwards, the Retrieve voice mail extension, 999, will be redirected to the Exchange server Menu. All Voice mail messages will be stored in Exchange.

**e164 number processing**

E164 numbers are numbers that conform to a standard format. Microsoft Outlook usually stores numbers as e164 numbers. If you store numbers as e164 numbers or use the Microsoft Outlook integration, you must “pre-process” these numbers and then pre-pend a prefix in order to trigger a specific outbound rule.
To process e164 numbers:

1. Specify your country and area code.

2. Specify whether your country code must be removed if the number to be dialed is in the same country.

3. Specify whether the area code must be removed if the number to be dialed is in the same area code.

4. Now enter a prefix, in order to trigger an outbound rule.

**Firewall options**

This section allows configuration of firewall specific options.

The **Allow non-sequential RTP ports** option needs to be switched on for some firewalls, for example Microsoft ISA server.

In the option ‘Tunnel VOIP traffic via VPN over Port’, you can specify via which port the 3CX VOIP client must tunnel its SIP and RTP traffic. The 3CX VOIP client includes a mini VPN that can tunnel all SIP and RTP traffic over a single port. This greatly reduces firewall configuration and allows you to use port 80 for remote VOIP clients (providing you are not already using port 80 for a web server).

**Other**

**Music file on hold**: Here you can specify a wav file with the music that you wish to play for callers that are on hold.
**Backup and Restore**

3CX Phone System includes a convenient backup and restore function, that allows you to create a complete backup of your phone system configuration to a file.

To backup data, run the Backup and Restore utility located in the 3CX Phone System Program group.

To restore phone system data, locate the backup of the phone system data and click ‘Restore’. Note that the current configuration will be OVERWRITTEN with the backup data, and any changes that you have made since performing the backup will be lost.

**Running backup & restore from the command line:**

3CXBackup backup / restore filepath [/? | /history | /prompts | /recordings

Where

Backup will backup the database
Restore will restore the database
Filepath is the location of the database to restore from or backup to

Options

/? Is this help message
/history will include the call history database
/prompts will include all system prompts
/recordings will include all call recordings.

Example

3CXBackup backup c:\data\3cxbackup.zip /call history /prompts /recordings

**Scheduling backup & restore**

Using the Windows scheduler you can easily schedule a daily phone system backup. To do this:

1. Go to Start > Accessories > System tools > Schedule Tasks
2. Double-click on ‘Add Scheduled task’
3. Browse to the 3cxbackup program, 3cxbackup.exe
4. Specify schedule and account to use.
5. After it is created, you have to modify the schedule to include the command line parameters that you need.

Note: In v 5.1 backup and restore was accessible from the web interface. This has been moved to a separate application that can be scheduled.
**System prompts**

System prompts are messages played to the caller by the phone system for standard situations within the voice mail and digital receptionist menus. For example, when the caller has listened to all his voice mail messages the system will play a system prompt that tells the caller that there are no more messages.

3CX Phone System ships with a default set of English system prompts. To modify the System Prompts, go to the ‘General > System Prompts’ page.

You can copy an entire prompts set and make changes to particular system prompts whilst keeping a backup of the original set. To do this, simply click ‘Create Copy’ and enter a new name for the prompts set.

In the prompts section all system prompts are listed, with their particular meaning and a path to the file. You can replace a particular file simply by recording the new prompt and then selecting the new prompt using the ‘Browse’ button.

**Update console**

This page lists the latest versions of phone system software, VoIP provider & gateway templates, prompt sets and translations. To check for the latest versions available, simply click on the ‘Update Console’ link in the General section.

The update console page will list any components that are out of date. Should you require that component, select it and click the download button to download the latest version.

Note that the actual 3CX Phone System software is not automatically updated without re-running the downloaded setup file.
Screenshot 29- Versions/Updates page
14. The HTTP API

Introduction

*Note: This feature is not present in the free edition of 3CX Phone System*

The HTTP API allows you to perform a number of actions via a simple HTTP post request. This allows you to trigger certain actions on the PBX from almost any application.

HTTP functions available

The available HTTP functions are listed in this section. For all functions, Localhost must be replaced by the IP of your phone system.

To disable an extension

You can programmatically disable an extension using the following call

```
```

where extnum and pwd are the extension number and password for the extension. To disable an extension, specify 1 as a parameter. To enable it, specify 0.

To disable external calls from an extension

You can programmatically disable outbound calls using the following call

```
```

where extnum and pwd are the extension number and password for the extension. To disable outbound calls, specify 1 as a parameter. To enable them, specify 0.

To record calls to and from an extension

You can programmatically enable call recording for an extension

```
```

where extnum and pwd are the extension number and password for the extension. To record calls, specify 1 as a parameter. To switch it off, specify 0.

To automatically trigger a call

3CX Phone System allows you to easily integrate calling functionality into any web based CRM package, or in deed any software that can make HTTP post requests. To launch a call to a particular number

```
```
Where:

* extnum – is the extension number of the user placing the call
* vmpin – is the voice mail pin number of the user placing the call
* to – is the destination number. This must include any prefixes necessary.
15. Fax server

**Introduction**

*Note: This feature is not present in the free edition of 3CX Phone System*

3CX Phone System includes a fax server that allows the whole network to send and receive faxes. The 3CX fax server is based on the T38 standard and requires a compatible T38 VOIP gateway. Compatible VOIP Providers are expected to be released in Q3 of 2008.

**Sending faxes overview**

Faxes are sent using the fax client built into all Microsoft Windows versions. The Microsoft fax client is feature rich and seamlessly integrated into Microsoft Office and Windows.

For all network clients to send faxes via Microsoft Fax, you will need to install the network fax server component of Windows 2003 / 2008 server. 3CX Fax Server integrates with the Microsoft Network Fax server service by installing a T38 driver. This T38 fax driver talks to the 3CX Fax server which sends out the fax via the VOIP Gateway or VOIP provider.

**Receiving faxes overview**

The receiving of faxes is completely handled by 3CX Fax Server. Faxes are forwarded to the 3CX Fax Server which receives the fax, converts it to PDF and then emails the fax to the configured email address. You will need to dedicate a DID or line to fax and route all calls on this line to the 3CX Fax Server extension.

**Configuring 3CX Fax Server**

The Fax server operates as a virtual extension and logs into the SIP server just as an extension would. Therefore you need to specify an authentication ID and password for the fax server to use. To configure the fax server:

1. In the management console, go to the General settings > Voice Mail & Fax delivery settings

### FAX Delivery Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Special FAX Extension Number</td>
<td>368</td>
</tr>
<tr>
<td>FAX Authentication ID</td>
<td>368</td>
</tr>
<tr>
<td>FAX Authentication Password</td>
<td>368</td>
</tr>
<tr>
<td>FAX Default Delivery Address</td>
<td><a href="mailto:nfr@3cx.com">nfr@3cx.com</a></td>
</tr>
</tbody>
</table>

**Screenshot 11 - Fax server settings**

Page 75
2. In the ‘Special FAX Extension Number’ field, specify the fax extension number. Any call forwarded to this extension will be assumed to be a fax and receive a fax tone.

3. Specify the FAX Authentication ID and Password – These credentials will be used by the fax server to login to the SIP server.

4. FAX Default Delivery Address – Specify the default email address to send received faxes to.

**Fax receiving configuration**

To receive faxes, you have to configure one of the lines or DID’s (if you don’t want to dedicate a line) on your VOIP Gateway to be a fax line, and forward all calls on this line to the Fax server extension. The Fax server will then receive the fax and forward the fax as an email. To do this:

1. In the Management console, create a new DID rule and specify the Fax DID/Line number which is dedicated to receiving faxes.

2. Expand the section ‘Route FAX Calls’. Select ‘All Calls’

3. Now select to which email address you want to email the received fax. If you select “Default FAX Destination”, the fax will be sent to the email address configured for the virtual fax extension number. Alternatively you can forward faxes to the email address configured for a particular extension. This allows you to create multiple DID rules so as to give people a personal fax extension.

**Fax sending configuration**

To send faxes, you need to install and configure Microsoft Fax as explained in the introduction. To do this, follow these steps:

**Step 1: Install Microsoft Fax Server**

Select a Windows 2003 or 2008 server that will act as the fax server. This does not have to be a dedicated machine, and it does not have to be (but can be) the same machine as 3CX Phone System. This machine will just have Microsoft Fax installed and the system load will be comparable to a print queue. The 3CX Microsoft Fax server driver can communicate easily with a remote 3CX Phone System.

**To install Microsoft Fax Services on Windows 2003:**
1. Go to Add Remove programs, Windows Components, and select Fax services. Click Next to continue.

2. You will be asked whether you wish to share the fax printer. Click Yes so that everybody in the network will be able to send and receive faxes.

3. The components will be installed. Click ‘Finish’ when done.

4. Now go to the services control panel and stop the Fax service. This step must be done before you run the 3CX Fax server install.

**To install Microsoft Fax Services on Windows 2003:**
1. Go to Control Panel and click on “Programs and Features”. Click on “Turn Windows Features On or Off”. The Windows 2008 Server Manager Display will load.

2. Now click on Roles and proceed to add a new role. The Add Roles Wizard will appear. Under Select Server Roles, tick on the Fax Server role. If Print Services are not installed, you will be prompted to install Print Services too.

3. Select the Fax Users or Groups that you want to allow sending of faxes on this server.

4. Select who can access the fax server inbox. Click Next to proceed to the Confirmation Page.

5. Click on the Install button in the Confirm Installation Page to install the Windows Fax Service on your server. This will complete the addition of the Fax Server Role in Windows Server 2008.

**Step 2: Install the 3CX Microsoft Fax driver**

1. Download the fax send module from [http://www.3cx.com/downloads/3CXfaxserver.msi](http://www.3cx.com/downloads/3CXfaxserver.msi)

2. Double-click to start the installation. Ensure you STOP the Microsoft Fax service from the services control panel applet before you run the 3CX Fax server installation.

3. You will be prompted to specify the IP or host name of the 3CX Phone System machine, as well as the port name. Specify the hostname or IP of 3CX Phone System, leave the port default at 4400. If 3CX Phone System is installed on the same machine, specify 'Localhost'

4. Setup will copy the files

5. Now go to the Windows services applet and start the Microsoft Fax Service

**Step 3: Configuring Microsoft Fax to use the 3CX Fax server driver**

**Configuring Microsoft Fax on Windows 2003:**

1. Go to the Microsoft Fax console (Start > Programs > Accessories > Fax > Fax console
2. Launch the Fax configuration wizard by going to Tools > Configure fax
3. Specify default company information.
4. Specify your dialing location. Be sure to include any prefix that needs to get dialed to get an outside number on the PBX!

5. Now select 3CX Fax Device 0 as the device to send faxes. Click Next.
6. Specify the outbound Fax ID to be used for your company
7. In the next step, do not select 3CX Fax Device for outbound faxes. This is not yet supported. For now faxes are received direct to email as PDF files
8. Click Finish. 3CX Fax is now installed and configured.
9. You can check this from the Microsoft Fax Service Manager – here you will see the 3CX Fax Device appear as one of the fax devices.

10. You are now ready to send faxes. You can send a test fax from the Fax Console, File menu. For information how to use Microsoft Fax, see its help function.

**Configuring Microsoft Fax on Windows 2003:**

1. Open Server Manager and expand the Fax Server tree display. Under Devices and Providers you will see the 3CX Fax Device as the Fax Sending Device for Outgoing faxes. In the Devices section and in the Providers Section, you will also see the 3CX Fax Service Provider.

**Screenshot 17 - The 3CX Fax driver installed**

2. Go to the Rules Section and specify the 3CX Fax Device 0 as the Target Device from the drop down list.

**Screenshot 18 - 3CX Fax driver in Windows 2008**
Step 4: Install the Fax clients

If you have not yet installed the Microsoft Fax clients, you have to install the Microsoft Fax client on the individual client machines and configure them to connect to the central network fax server. This is a simple process and well documented in the Microsoft Help Files. Note that these are the standard Microsoft Fax clients; they have not been modified by 3CX in any way.

Installing the fax client in Windows XP

1. Go to Printers & Faxes, and select Add Printer
Installing the network fax printer

2. Select ‘Network printer’

3. Enter hostname of machine which you have installed Microsoft Fax servers, followed by fax, e.g. <servername>/fax. Be sure to specify the machine running Microsoft Fax, not the machine running 3CX Phone System. This could be on the same machine but need not be.

4. Select whether you want to make it the default printer

5. Click Finish. Printer driver is now installed

6. To send a fax, print to this new fax printer or select File > Send To > Recipient using a Fax Modem

Installing the fax client in Windows Vista
System requirements for the clients

- Windows Fax and Scan should be installed
- Print Services should also be enabled.
- The Fax printer on the Server machine should be shared to network users
- Network Users should be granted permission to be able to print on this Fax Printer.

To install the client:

1. Click on Start, Programs and click on “Windows Fax and Scan”
2. Select ‘Fax Accounts’ from the Tools menu.
3. Click “Add” to add a new account.
4. In the fax setup wizard, click on “Connect to a fax server on my network”
5. Enter the location and printer name where the fax server has been installed

![Fax Setup](image)

**Screenshot 22: Fax Shared Printer location and Name**

6. Click on Next to complete Fax Account registration. You are now able to send faxes from Windows Fax and Scan through the 3CX Fax Server Driver.
16. Troubleshooting

Introduction

If you have problems configuring 3CX Phone System, you can access the following sources of information for help:

- The manual – most issues can be solved by reading the manual.
- The 3CX FAQ – http://www.3cx.com/support/index.html
- The Phone configuration guides – http://www.3cx.com/sip-phones/index.html
- The Support forum – http://www.3cx.com/forums/
- Our support system

Manual

The manual describes the installation process in detail. Many of the questions we receive in support are clearly documented in the manual. You can always find the latest version of the manual here:

http://www.3cx.com/support/index.html

Configuration guides

Be sure to follow the configuration guides for your gateway or sip phone:

- SIP Phone configuration guides – http://www.3cx.com/sip-phones/index.html

Support FAQ

3CX maintains an FAQ, which includes answers to the most common problems. If you have a problem, please consult the FAQ first. The FAQ can be found at http://www.3cx.com/support/index.html

Web Forum

User to user support is available via our web forums. The forum can be found at:

http://www.3cx.com/forums/
Request support via our support system

If you have purchased a support package from 3CX, you can contact the 3CX support department via the support system. Login details would have been provided to you by email.

When requesting support, include the ‘Support info’ data. 3CX Phone System can automatically generate a file which includes all relevant support information. **NO PASSWORDS TO PHONES OR VOIP PROVIDERS WILL BE INCLUDED.** The data will NOT be sent automatically. You will be prompted for a location to save the data, so you can check what data will be sent to us before you send it to us.

To generate the support info file:

1. In the 3CX Phone System Program Group, start the ‘Backup and Restore’ tool.
2. Click on the button ‘Browse’ next to ‘Generate Support’.
3. You will be prompted for a location to save the data. Enter the file name to be generated. You can review the data that will be sent prior to sending it to us.
4. Login to the 3CX support system, and attach the information to your support request.
5. Include a detailed problem description. It should clearly indicate what the exact problem is, and when it occurs. Mention what hardware or VoIP provider you are using with 3CX Phone System.
## Index

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extensions</td>
<td>21</td>
</tr>
<tr>
<td>Importing extensions</td>
<td>28</td>
</tr>
<tr>
<td>media server</td>
<td>13</td>
</tr>
<tr>
<td>office hours</td>
<td>33, 49, 66</td>
</tr>
<tr>
<td>outbound route</td>
<td>39</td>
</tr>
<tr>
<td>PSTN Interface</td>
<td>34</td>
</tr>
<tr>
<td>PSTN lines</td>
<td>29</td>
</tr>
<tr>
<td>SIP phones</td>
<td>11</td>
</tr>
<tr>
<td>Skype</td>
<td>35</td>
</tr>
<tr>
<td>Troubleshooting tips</td>
<td>27</td>
</tr>
<tr>
<td>VOIP Gateway</td>
<td>29</td>
</tr>
</tbody>
</table>